Now that you’ve bought OmniWeb
we’re not going to try to sell you on

it any more.

Instead, we’ll show you how to use it.

We think OmniWeb is the best way to
surf the Web; as a matter of fact, that’s why we made it in the
first place. We think OmniWeb has more advanced and useful
features than any other browser — features that we wanted,
and features we think you will find useful too. This manual
serves to give you a tour of OmniWeb and, like a vacation in an
island paradise, we think that once you’ve seen the sights you'’ll
want to live here. We hope you’ll join us, relaxing and sipping

drinks on the beach while other Web surfers struggle.

Of course, if you are looking for all the details, OmniWeb also
has much more detailed online help facilities — this tour is just

to get you hooked.
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Step 1:

Insert the OmniWeb CD into your Macintosh’s CD-ROM drive. You should see a window
similar to this one:

8006 OmniWeb =)
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‘ * 7o install this software, drag the |
~icon below to your Applications
. . = ~ folder (or whatever other folder
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In addition to the OmniWeb application, your CD also contains some useful information for
helping you get started (in case you forgot to look at this manual, but you're clearly smarter
than that), and unlicensed versions of the Omni Group’s other products for you to try out
and fall in love with as well.

Step 2:

If you want, you can go ahead and run OmniWeb now by double-clicking the OmniWeb icon.
But you probably don’t want to run OmniWeb from the CD, since you'd have to have said

CD in your computer all the time. Instead, you should drag the icon to a folder on your
local or network disk.

Where you put it is up to you; however, most Mac OS X applications work best if you put
them in the main Applications folder on your hard disk. If you have multiple users on your
computer, OmniWeb will then be accessible to all of them. (Note that you’ll have to be logged
in as an administrator to write to the Applications folder.)

If you're the administrator of a Mac OS X network (you'd know if you were) and
you’ve bought multiple copies of OmniWeb, you may want to put OmniWeb in the
/Network/Applications folder so that it can be available to all network users.



Step 3:

Run OmniWeb for the first time by double-clicking on its icon. You’ll be presented with a
panel letting you know that you should enter your license key. Click Licenses..., and a new
window will appear:

Licenses

No License Available

Add or remave licenses below. If you don’t have a license, click on the
‘Buy Licenses..’ button below ta go to our on-line store, or call
B00.315.0MMNI (206.523.4152 x100), or e-mail <sales@omnigroup.com>.

Seats Owner Entered Expires
i r——
E Buy Licenses.. f Add License... ‘

This is the Licenses window, in which you can keep track of any OmniWeb license(s) you may
own (for more information about its general use, see the online help.)

Step 4:

Click Add License..., and a sheet will appear in which you can enter your license information
as it appears on the CD sleeve. Also, here you can choose to install your license for Personal,
Computer, or Network use. Once you've entered the license information, click Save to save

it (as you might expect).

Personal, Computer, or Network? Huh?

When installing OmniWeb, you’ll want to decide who else can use your license (see sidebar).
There are three ways you can use your license:

A Personal license is available only for you, the user who installed it. It’s stored in your home folder,
so it is only available when you're logged into your account.

A Computer license iswhat you would usually choose: it’s available to any user who can log into
your Mac.

A Network license is available for any user on any machine on your Mac OS X network, and is
generally only used if you have bought lots of licenses (for instance, at a university lab).

Feel free to copy OmniWeb to other computers without its license: it will function in a
limited mode as a document viewer when unlicensed.

OmniWeb’s license terms:

Each OmniWeb license you buy allows you
———— to either:

e Have as many users you want use OmniWeb on
one machine, or

e Have one user use OmniWeb on as many
machines as she wants.

Note that doing both is not allowed — licenses
aren’t “floating” and thus, if you have one license
and two machines in your house, and your
roommate also wants to use OmniWeb, you can
either decide that both you and the roommate can
use OmniWeb on one of your machines, or that
you can use OmniWeb on both machines and your
roommate can buy her own copy.

So, in this example, you’d want to install your
license as a Computer license if you’re trying

to share OmniWeb with your roommate on one
machine, or as a Personal license if you want to use
it on either machine and not share with her.

For companies and other institutions, a simplified
way of saying this would be: “You should purchase
as many licenses as you have either machines or
total potential users, whichever is fewer.”



Overview

OmniWeb is a great way to navigate the Internet, with all of its

nooks and crannies. It provides easy access to all of your favorite

sites, and makes them more beautiful than ever before.

Convenient, configurable toolbar allows
you to choose the buttons you use most,

OmniWeb supports many different languages and text
encodings, ensuring that no matter where you’re from,

and arrange them however you like.

% OmniWeb

» [ Favorites
> [WApple
[ Mac News
»[7 Computing News
¥ [ News & Media
T Seattle Times
& New York Times
B NN
% Business Week
% Discovery Channel / TLC
% National Geographic
& Newsweek
% NPR: National Public Radio
% The New York Times

W% PBS: Public Broadcasting ...

% Time magazine

» [ Shopping
b |7 Entertainment
b [7 Cool stuff
P [/ Resources & Reference
» [ Software Developers
» [ Developer Resources

% 0ld Graffle page

% Inside Carbon : Apple Help

% ASCII - SO 8859-1 Table wi...

% Unicode and multilingual su..

% Inside Carbon : Speech Synt...

W AltaVista - World / Translate
% The Interface Mafia

Yy Select nexs new bookmark|(2

Y Filter dead bookmarks (fy

Keep your inner librarian happy — organize all your
favorite sites into convenient categories. Need to
know when a site changes? OmniWeb can check
them automatically and inform you of updates.

i:) % omniweb: /StartPage/

W Apple R MacSurfer Wy Blue's News [ JForums % Foundation Reference 4 AppKit Reference

AN

O M NI W E

Apple « AltaVista » Ask Jeeves « Excite « Google
GO.com = Lycos » WehCrawler » Yahoo

your web pages will look beautiful. (Warning: offer not
valid for pages that were designed ugly.)

Search:

¥ % omniweb:
% OmniWeb 4.1
¥ % The Omni Group
% The Omni Group
% The Omni Group: Ca...
% The Omni Group: Dev...
% The Omni Group: Ga...
% The Omni Group: Ap..
¥ % Apple
% Apple
% Apple - Mac 0S X - N.
% Apple - Mac 05 X
W Apple - iDVD
W Apple - DVD Studio Pro
% Apple - Products - Po...
% Apple - Products - Po_.
W Apple - Hardware
W Apple - PowerBook
> g file
¥ % newforums.macnn
% MacNN Forums
¥ % Welcome to Apple Macin...
% School buys 700 iBao.
% Starcraft, Brood War ¢
% Welcome to Apple Ma. ..
P T Accelerate Your Macinte...
¥ T versiontracker.
% Macintosh Software U
» % MacSurfer's Headlige Ne.

Forgot where you saw that cool link? OmniWeb can
search through all your visited pages as quickly as you
can type, making finding lost stuff a snap. (Your lost
keys and photo albums aren’t in this drawer.)



Other Insanely Great Features

It doesn’t stop there. OmniWeb has many useful, convenient features available at the
click of a button.

(e}
(]

The Downloads panel helps you check the progress of current
downloads, track the files you've already downloaded, find them
on your hard drive, and even download them again if you lost
your first copy.

OmniWeb’s source editor can not only edit the source as it was

@ - downloaded — it can also reformat it, highlight errors, redisplay
<headtr= your changes in the browser before saving them, and store them
e to your server. It’s a great tool for Web designers, tinkerers, or

e students of HTML.

(&

for Mac OS X, including Macromedia Flash, QuickTime, and

j OmniWeb supports the most popular Internet Plug-ins available
@ iTools, and new Plug-ins are added all the time.

eabe

Q

Omniw Jagged, ugly text got you down? OmniWeb uses the Quartz
lan gLl rendering in Mac OS X to draw beautiful anti-aliased text.
X web | Suddenly every web page looks better.

‘;\ : We know that we can’t cover everything in a manual like this, so
4‘7 ‘3 we’ve included a convenient online help facility. It goes into a lot
b more depth on specific features, so don’t get all bummed if this

manual isn’t detailed enough.

Tips and tricks

Option-dragging a link opens a new window and
immediately starts you dragging this window
(while the page loads in the background).

You can type the first letter (or few letters) of

a link’s label to select it, use Command-up and

Command-down to select next or previous link,
and hit Return to follow it (or Command-return

to open it in a new window).

When you’'re typing in the URL field and you have
several matches available, you can use up and
down arrow keys to select between them, and
then either press Return to follow the current
selection or press F5 to fill in the next part of
the URL from it.

Holding down Option while the Bookmarks
menu is up changes Show Bookmarks Drawer
(Command-B) to Open Bookmarks Window
(Option-Command-B).

Hold down Option and Shift in the File menu and
you see Save As... turn into Save As PDF....



The Toolbar is an essential part of getting the most out of

OmniWeb. And customizing it is like going to a candy shop — all

kinds of tasty icons are available.

i Below is the default Toolbar. It’s a good starting point, as it
The Toolbar J Ip
contains the most commonly used features in OmniWeb. But we

encourage you to customize your Toolbar, by selecting ‘Customize

Toolbar’ from the Browser Menu.

The Address Field: good for choosing where to go,
and seeing where you currently are. Note that for
commercial sites you can just type the company
name without the ‘www’ or the ‘com’.

These arrows will chase each other until the page is
These buttons let you quickly jump finished loading. And if you’re curious why it’s taking
back and forth among pages you’ve so long to get a page, clicking here will bring up a
visited in this window. panel that will shed some light on what’s going on.

e 08 Ty The Omni Group =

==

e T

"

_. \:/ L shttp:f fwww.omnigroup.com/ ‘l'. r

B

_K‘HDmniWeb Help ‘{]Apple "{'Jl'u'lar_ 05 X ._li'l'he Omni Group

Drag links to your favorite sites to this bar, . N
and they’ll be accessible with just one click. Wz.:mt to see if a page has changed?
Click here to reload the page.

The Back and Forward buttons have Bored Wit_h a page? The stop
tiny black triangles under them. button will halt any loading
Clicking and holding on one will page right in its tracks.

bring up a small menu, listing the
sites behind you or in front of you,
respectively.



Other Tasty Buttons You Can Add

First: |John

Last:  Smith

Country: | USA G

Noheadte

ext/hi

=< ieb
</head>
<body backg

Show Info

The Show Info button allows you to get details about the web page
you're viewing — from where it and its embedded images came, how
big it is, when you loaded it, and other useful information.

Find On Page

Can’t find what you’re looking for on a page? Clicking here will bring
up a helpful panel that will quickly and easily help you locate the
words you want, assuming they are on the current web page.

AutoFill Form

Keep filling out the same forms again and again? Sick of typing in
your name every time you want to post on a message board? AutoFill
Form can remember all sorts of data — saving you typing effort.

View HTML Source

Clicking the View HTML Source button will bring up OmniWeb’s
powerful Source Editor. You can edit a page’s source code and save it
to your disk, or even upload it to your web server.

Spaces and Separators

Keep clicking on the Back when you really meant Forward? Put some
spaces or separators between buttons if you like. Put a Flexible Space
in to make all the items after it stick to the right edge of the toolbar.

Customize

Obsessive about your toolbar? Now there’s help. Put this button on
your toolbar and customization is just a click away.

Toolbar tips

You can pull the address field off of the main
toolbar, in which case it will appear in its own
separate section. You can even set it to be hidden
by default, in which case it will only appear while
you’re entering a URL; i.e. when you create a

new window or select Browser » Go To Location
(shortcut Command-L).

For fast browsing, turn off inline images and add
the Load Images button to your toolbar. Then you
don’t have to wait for a page’s images to load for
a quick glance at the page, but when you want the
full monty all the images are just a click away.

Toolbar customization

e Use Tools » Hide Toolbar or click the lozenge in
the upper-right corner of a window’s title bar to
hide and show its toolbar.

e Use Tools » Customize Toolbar... or use Option-
command-click customize your toolbar.

e Command-click on the toolbar lozenge to select
a different display mode (Icon and Text, Icon
Only, or Text Only).

¢ Command-drag a toolbar item to move it
(or remove it) without entering the customize
toolbar mode.

e Control-click on the toolbar to get a context
menu which lets you do all of the above and
more.

OmniWeb uses the standard toolbar mechanism
from Mac OS X’s Cocoa frameworks — so most
of these shortcuts will also work in other Mac OS
X applications, including Mail, Internet Connect,
Project Builder, and (of course) OmniGraffle.
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Bookmarks

Everyone has her own favorite sites — but who wants to go
through them every day, hoping for a change? OmniWeb tells you

when a bookmarked page has been changed or even gone away.

This is just an ordinary bookmark. Double-click on
it or drag it to a browser window to go to its page.

866 file:Bookmarks.html

Bookmarks

This bookmark folder is used for organizing bookmarks.
To create a new folder, select Add Bookmark Folder from 3
the Edit Bookmarks section of the Bookmarks menu. (This ——%t= Favorites

folder’s name is in boldface because it’s special — the % OmniWeblHelp
items in it appear on your browser windows’ Favorites .y

S Apple
bars.) oy

S Mac 05 X
This is a bookmark folder that is also a link. Draga ————&9{ The Omni Group
bookmark underneath and to the right of any other 'ilﬁﬁ-PD!E

bookmark to make the latter bookmark a folder/link.
% The Apple Store

% Mac 05 X
% iTools
% QuickTime
b [T Apple Developer Connection
B[ Mac News

The web page this bookmark points to has changed since
the last time you looked at it, so its Zap is green.

Bookmarks without labels or URLs visually separate other
bookmarks irl this window and the main menu. You can B[ Computing News
create one with the Add Bookmark Separator in the Edit .

B Mews & Media

Bookmarks section of the Bookmarks menu.
B | " Shopping

B | Entertainment

P | Cool Stuff

b | 'Resources & Reference
b | ' Software Developers
| Developer Resources
% Old OmniGraffle page

OmniWeb couldn’t get to the web page this bookmark
points to the last time it checked, so its Zap is red. This
may mean the page has gone away, but it could also

mean there are Internet connection problems somewhere ";“ Select next new bookmark (2)
between your computer and the web site.

" Filter dead bookmarks (1) 1

Steps through green bookmarks. Option-click steps backwards through Pulls down a sheet allowing you to
them. Shift-click closes any folders that got opened in all that clicking. delete unreachable sites en masse.



Bookmark Info Panel

Choose Show Info from the Tools menu to bring up the general Info window, which will
show Bookmark Info if you have a bookmark selected. This window lets you inspect and
change all the information associated with an individual bookmark.

(&
!

&)

Bookmark Info

b =
L) Apple - Mac OS5 X

Labal Mac 05 X

URL http:/ fwww.apple.com/macosx |

— 1%

Motes  Apple's next-generation operating

system.

Open as: '@ web page
D bookmarks window

Automatic change checking

Check every defautt =3
Last chacked

Word count 0

Check '_1_7 Page was unreachable

Row @ Has unviewed changes «——

This label is used to identify the bookmark in lists
and menus; usually it’s the name of the document.
If you type this label (or part of it) into a browser
window’s address field, the bookmark will appear in
a drop-down list for easy selection.

This is the URL, or Web address, of this bookmark. If
it’s empty, this bookmark is just a spacer or folder.

Need to keep some information about this
bookmark? The Notes section can store any
descriptive text you like, and it is searched when
you use the Find panel on a bookmark’s window
and is used for address completions like the Label
above.

Since OmniWeb stores its bookmarks in HTML files,
any bookmark can link to another bookmarks file
that you’ve created or that’s on the Web.

How often do you want to check this page for
changes? Set different times for each bookmark
here, or just use the default set in Preferences.

This will be checked if OmniWeb couldn’t get to the
page when it tried to check it.

This will be checked if the page has changed since
you last read it. You can change either of these
yourself if you think OmniWeb has bad info.

About Zaps

Zaps are OmniWeb’s way of representing web

page addresses (also known as URLs, or Uniform
Resource Locators). Zaps look like little lightning
bolts. Other browsers use little ‘@’ signs, but aren’t
Zaps cooler? The color of the Zap tells you a little
about the page it points to.

3
3

X
e

A blue (or graphite, according
to your system preferences)
Zap represents a normal page.

A green Zap represents a page
that has been updated since
you last read it.

A red Zap represents a page
that has been moved, deleted,
or is otherwise unreachable.

A Zap with a tiny lock means
the page this Zap represents is
secure.

What can | do with a Zap?
Double-click on it to open it in a new window.

Drag and drop it onto a browser window to open
it in that window.

Drag it to another web browser to open its page in
the other browser.

Drag it to your Dock, a Finder folder, or your
Desktop to create an icon that can open the page
again later.

Drag it to Mail’s Compose window or any other text

Click this button, and OmniWeb will go out and check
(in the background) the web page this bookmark points
to, and mark it as either updated or unreachable if it
has changed.

document to paste the URL there.
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With so much information on so many pages, who can remember

where that one obscure fact was? OmniWeb’s History is like an

elephant — it never forgets. It can keep as many or as few pages

as you like, and instantly find what you’re looking for.

Global history remembers all 4_Fclnb'al History 1 Browser History |

of the pages you’ve been to

for a long time (exactly how Search:
many pages and just how long = =
OmniWeb remembers them is ¥ & omniweb:
up to you). Pages are grouped % OmniWeb 4.1
by the site they were on, so if ¥ % The Omni Group
you visit 1000 pages on a single % The Omni Group
S|.te they won’t take over your % The Omni Group: Co...
history. % The Omni Group: Dev.__.
Browser history shows only % The Omni Group: Ga...
the pages you’ve read in this % The Omni Group: Ap...
drawer’s attached browser v T Apple
window — think of it as a -

D Apple

history of your current session.
yory % Apple - Mac 05 X - N...

% Apple - Mac 0S X
% Apple - iDVD
% Apple - DVD Studio Pro

T Apple - Products - Po...
% Apple - Products - Po...

% Apple - Hardware
% Apple - PowerBook
> Gfile:
¥ % newforums.macnn...
% MacNN Forums :

¥ % Welcome to Apple Macin...

As with Zaps anywhere in % School buys 700 iBoo._

OmniWeb, you can drag any of % Starcraft, Brood War c...

these Zaps to a browser window % Welcome to Apple Ma...
and that window will load the
Zap’s page. Double click on ¥ T versiantracker
one, and OmniWeb will load its - oz

page and automatically close Ty Macintosh Sﬂmf”are Hsss
the drawer for you, because it P % MacSurfer's Headline Ne. ..

P 5 Accelerate Your Macinto...

wasn’t raised in a barn.

Looking for a web page you've
seen, but you can’t remember
the URL? If you can remember

a specific word or phrase from
the page, type it in here, and

the history list will shrink to only
those pages that match the words
you entered. Clear out the box,
and you’ll be back to the original
list.

Click on a triangle to reveal all of
the pages you’ve read on one site;
for instance, this group shows

all the recently visited pages at
www.apple.com.



“Autocomplete” and the Address Field

OmniWeb also has the ability to search your history (and your bookmarks) while you're
typing in an address in the Address Field. Just type in any part of the address or the
title of the page you want, and a box will drop down displaying all the pages from

your history and bookmarks that match the letters you've typed so far. To go to one of
those pages without typing the rest of its address, press the down arrow key until it’s
selected, and then hit Return.

‘;i graffle| ¥ These are the phrases
- http:/ fwww.graffle.com/ g = you’re looking for.
http:f fwww.allosx.com/997 1287560 MacMM Reviews OmniGraffle 1)
http:/ fwww.apple.com/downloads/m Apple - Downloads - Productiv
http:/ fwww.omnigroup.com/ The Omni Group These are the pages that
http:/ jwww_.omnigroup.com/applicat The Omni Group: Applications: had matching titles or
http:/ fwww.omnigroup.com/applicat omnigroup. . +sidebar.html 4 addresses.

History in the Address Field

Clicking on the triangle on the right side of the Address Field will drop down a box
displaying your history. This is easier than opening up the history drawer if you're
looking for a site you read recently.

a';i omniweb: /StartPage/ v This is the page you're

currently viewing.

- The Omni Group: Applications: OmniWweh -

The Omni Group: Game Ports :

The Omni Group: Applications: OmniQutliner

Apple - iTools Login

Apple - iCards

Apple - iTools

apple...index.himl

Apple - Science & Technology - eyeExpert LLC: Seeing Eye to ...
Apple - Mac OS5 X

Apple

The Apple Store (L.5.)

These are pages you've
been to recently.

How far back can OmniWeb
remember?

You can control how much or how little History can
display using the History Preferences. For instance:
e How many addresses per site?

 How many sites total?

e How many addresses should be shown?

e Should history be saved when quitting?

e How many days should history be kept?

For more information, see the online help.

Dang, you guys are smart.

We'd love to take credit for thinking up our unique
indexed history, but actually that idea came from
a clever Mac columnist named John Martellaro, and
we coded it up and released it a few months later.
While lots of our cool features were invented by
Omni’s super-smart engineers (because we wanted
to use them), a bunch came from customers as
well. So please tell us what would make browsing
more fun for you, and we’ll try to write it. It’s like
having your own personal code gnomes. (Warning:
we cannot make OmniWeb wash your socks.)

11
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Downloads

There are lots of files to download on the Web — games, music,
new Omni products — but once they’ve been downloaded, how
can you find them? What if you accidentally delete them? And
what’s taking that download so long? OmniWeb’s Downloads Panel

will show you all of this and more.

Click here to re-download
the selected file.

Click here to stop

downloading the Click here to show the selected
selected file. file in the Finder.
O (&) | Dow\nloaﬂs
——— i
l Reload e Stop ! !_D__! Rewveal in Finder 83 Abandon Download ———— This button can do many
= things, depending on what
3| OmniGraffle-1.1.4.dmg you’ve selected in the list.

1.7 ME download complete, 4.8 MB/sec
- — If no download is selected, it
d| OmniDiskSweeper-1.0.dmg becomes Clear All Finished,
961.3 kB download complete, 5.3 MB/sec . . ..
! ; which will remove all finished
— €] MacQuake3-1.30-05X-bL.sit —_— downloads from the list.
6.9 MB of 26.7 MB, 30.2 kB/sec, about 11 minutes

If you click on a currently
downloading file, it becomes
Abandon Download, which

MNet address: http:/ /homepage.mac.comtuncer /MacQuake3-1.30-05%-b1.bin will stop the download and
remove its entry.

If you click on a completed
download, it becomes
Remove From List, which will
remove the currently selected
download from the list (but
doesn’t delete it from your
This is where the selected file is being put on your hard drive. disk).

Local file: ~/Desktop/MacQyake3-1.30-05%-b1 sit

This shows from where you got the selected file.

Each line tells you about the current status of the download it represents: whether
it finished or failed or is still in progress, how much of the file has been
downloaded so far and at what speed, and how much longer it’ll take. Dragging
the icon that appears here is the same as dragging the icon of the downloaded
file in the Finder; for example, you can drag the file into a Finder folder or Mail
from here.



INTERMISSION

Phew. Had enough yet? Well, there’s more to come. But pace yourself — you don’t
want to learn too much too fast. Take a break, get a glass of water, do some
stretches, and come back when you're ready for more.

13
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OmniWeb allows you to choose exactly how you want it to work —

: ’ from big things like how you want images to be displayed, down
D to small things like what default font you’d like to use. Even the

. Preferences panel itself is configurable.

Preferences

Click here to show all the

preferences available. Keep changing a certain set of options again and

again? Drag your favorite Preferences up here so

Browse through the you can find them more quickly.

preferences using
Previous and Next.

8 OmniWeb Areferences =
-_=||.- 1 ™ 3

@ “© F 0l @« @®

Show all | 15 M EGeneral Font & Color Bookmarks Privacy Compatibility Cookies

Basic

EolE 8 8 F

Applets AutoFill Bookmarks Display Downloads Font & Color General
7, — ol 7 Y !
Fi .5 el | 1" % (
S = 3 L 8 < ®)
History Images Shortcuts Source View Speech JawaScript Update
Advanced
”~ (@) @ éﬁ_ ®:
Compatibility Cookies HTTPS Privacy Plugins

Basic Preferences cover most of the options you’ll care about for general use.

Advanced Preferences are for more complex options; you won’t need to mess with them in the course
of everyday web browsing, but if you’re a system administrator or “power user” who likes to have fine
control over every aspect of your computing experience, you’ll find the more esoteric settings here.



Some of Your More Commonly Loved Preferences

General

The General Preference is one of the most useful. It contains settings
for your Home Page, autocompletion, drawers, and how to open new
windows.

Display

The HTML Display Preference contains settings that affect how
OmniWeb renders HTML pages: whether links are underlined, how to
handle pages with unknown character encodings, et cetera.

Font & Color

Everyone has their favorite fonts and colors. Pick your favorites for
drawing Web pages that don’t specify any. Note that many pages
already have fonts and colors, and will ignore what you pick here.

JavaScript

Hate annoying popup windows? The JavaScript panel allows you to
limit the effects of JavaScript, or even turn if off entirely. You can also
choose to have a debugging console show you what’s happening.

Shortcut

Want a quicker way of getting to your favorite pages? Using the
Shortcut Preference, you can assign short names to whatever pages
you want. “leetwarez” could be www.omnigroup.com.

Compatibility

Need to pretend you're a different browser? Use the Compatibility
Preference to claim you’re someone else. Or don’t, and let the world
know that you’re proud to be running OmniWeb.

Privacy

The Privacy Preference will help you get rid of ads and prevent
websites from tracking you. No more virtual footprints or irritating
flashing boxes all over the place. (What a relief.)

Why would | change my
compatibility preference?

Well, some sites are really worried about being
displayed correctly, so they check specifically to
see if you are using some other browser, and just
assume all other browsers won’t work. Not really
fair, is it, since they don’t even give OmniWeb a
chance? Well, you’ll show them. Just change this
preference and they’ll never know what a rebel
you are. On the other hand, it’s a good thing

to let OmniWeb truthfully identify itself — if web
site operators see that lots of people are using
OmniWeb, they might decide to make sure their site
works well with it.
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Source Editor

Someone has to write all the pages that make up the Web.

OmniWeb is great if you like to get your hands dirty with HTML

and JavaScript. The Source Editor allows you to edit HTML source,

automatically format it, redisplay it, and store it back on its server.

Redisplay this page in a
browser window, showing any

Save this page to your changes you may have made.
local hard drive, or to
the server from whence Make the HTML take up Reformat the HTML for humans,

it came.

0o

as few lines as possible. indenting tags where appropriate.

o index.html ‘

. i_ . : b, :
Reload this J‘Y '\ﬁ“._.dL ﬁ! : ‘f" é} As received

page from

its disk or Refetch Save Redisplay @ Compact Reformat Wiew

server. {htm—l_}
<head>

<meta http-equiv="content-type"
="text/html ;charset=1s0-8859-1">
<title>My Web Page</title>

content

</head>

<body background="aquastripe.gif"”
bgcolor="white" text="#222288"

30

w [ 4 (==

A

‘—’

Choosing As Received will show the HTML source code exactly as it was sent by the
server it came from (or loaded from your hard disk).

Choosing As Processed allows you to see what the document looks like after any
attached JavaScripts have run — since many JavaScripts alter the HTML of the pages
they’re in, this can be useful for debugging your scripts. To enable this option, you’ll
need to enable Keep processed streams in Source View Preferences. Choosing As
Processed (7-bit clean) will translate characters back to entities whenever it’s necessary.



The JavaScript Console

OmniWeb’s JavaScript console is another excellent tool for Web design. It allows you to
see the JavaScript that’s being executed, find any errors, and even enter new JavaScript
to be evaluated dynamically.

To activate the JavaScript console, make sure this option is

E Show debugaing console checked in the JavaScript Preferences pane.

This will cause a console window to appear for each page you visit which contains
JavaScript code.

866 JavaScript: omnigroup...

'Y
M= F

[no result]
[Load function callback]

function onload|{event) {
preloadlimages(); -
}

This is a recently evaluated undefined
JavaScript expression.——— 2 4 2

This is the result of —4

evaluating that expression. document.location
hittpiwww.omnigroup.com/
foo
This is an error. Oops. console:1: foo is not defined 'IL

[ inspect |

TR

fh

Type the name of a JavaScript object here and click inspect and
you’ll see a description of that object.

Type in a JavaScript expression here and click evaluate, and watch
it get evaluated right before your eyes!

Don’t like typing colors or links?

In the HTML Source editor, drag in a color (from the
Color panel or a color well) to automatically get its
HTML color code. Drag in a zap or link to paste a
fully-formatted anchor tag that references it.

More about the JavaScript Console

For more detailed information on using the
JavaScript console and other advanced JavaScript
features, see OmniWeb’s online help pages.
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Online Help

Stuck on something? Excited by the gory details? OmniWeb’s
online help system can answer most any question that you might
have. (Questions that aren’t about OmniWeb will have less useful

answers.)

And if the online help system isn’t quite enough, you can always

e-mail us and we’ll get back to you as soon as we can.

Dmniwet} HEID Opens the online help pages.

HTML GUE r"|.lri Ew Shows a summary of all the HTML tags
OmniWeb knows how to display.
D I"I"I I"l | WE' h‘ P rﬂd LI tt Pag E Takes you to the OmniWeb home page, where
you can find out more about OmniWeb,
SE n d F EE d h a_c k download the latest version, get help, or
LI ]

check out our other products.

Clicking here will tell your e-mail client to start a message
addressed to our feedback address. You can tell us what you
like, any problems you have, or really anything that’s on your
mind. (We can’t fix everything in the world.)



Online Help Pages

OmniWeb’s online help is a set of web pages, organized by topic. Each topic presents all

the detail that can be provided on a given subject, with links to related topics.

Our online help is intended to be an exhaustive reference, whereas this manual is
aimed at giving an introduction to the broad concepts in OmniWeb. So, as we keep

saying, if you don’t find enough detail here on any particular topic, please look in the

online help.

806

% OmniWeb Help =

—
d Il

N

| W Apple W MacSurfer % Blue's News |

"%y omniweb:/Helpf v @

arums n Foundation Reference Tj.ﬁppKil Reference

€& OMNIWEB HELP

Frequently Asked
Questions

Browsing the World
Wide Web

Customizing
OmniWeb

Using Bookmarks

Editing HTML Source

Reference

Advanced Topics for
System
Administrators

Click on a topic to the left to find out more about it, or click on a question below
to find the answer.

How do | make OmniWeb remember its window size?

How do | customize the toolbars?

How do | install and use plugins?

How do | import bookmarks from other web browsers?

How do | edit and organize my bookmarks?

2001 The Omni Group

What if that’s not enough?

The Internet is a big place, and everyone uses
computers in a different way. So if our help system
isn’t enough, here are some other options.

22+ ~ce There’s always our web site- check here
b for updates, tips, and other breaking

{-‘/’)\“ news.

http://www.omnigroup.com/
applications/omniweb/

Maybe other users have had the same
problem. There’s a great and very
helpful community on our mailing list:

http://www.omnigroup.com/
applications/omniweb/omniweb-I/

And finally, if you’re still stuck, you can
always send us e-mail at:

omniweb4@omnigroup.com
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There’s a term for a person who wants a little more out of their
Applications — the Power User. If you’re one, you’ll probably want

to know all about the pages you’re looking at, any problems that

happened, and the status of your network. OmniWeb is designed
Advanced from the start to be simple — but if you absolutely crave power,

it’s there waiting for you.

Network Activity

The Network Activity panel is designed to help you check the status of OmniWeb’s Internet
connections and processes. You can see all the current pages and images being fetched, stop
individual ones, or even stop them all.

Activities are sorted by category, like “downloads” and “web pages”.
Click the disclosure triangle to hide the listings within it.

[&] (&) Network Activity
TWebuage:ilﬁl A
¥ HTML Document smacnn..» Here’s an actual HTML document — just the HTML
Inline Image swwwé.macnn...logomain.gifs (5] text file, that is.
Inline Source swwwd.maenn.. orangerep.gife 5]
Inline Image stribalfusion.speedera.net... 12126.gifs Each of these subtasks is an image, script, or other
Inline Image «a.tribalfusion...i.ad?site=MacNNcomd&adSpace -l file included by the HTML page containing it, each
Inline Image skermit.macnn...macnnmobilel_100x100.gifs @ of which is downloaded separately.
Inline Image «kermit.macnn...macnnmobilel_100x100.gifs @
Inline Image «kermit.macnn...op_free.gifs ®—— Blue dots show which processes are currently
Inline Imacae skermit macan  ramiest 100x32 aifs e active. The ones without dots aren’t yet active,
Address: http:/ fwwwwd. macnn.com macnnsite (logomain.gif - because we don’t want to overwhelm the server.

Red dots show processes that have failed because

they encountered an error.
Status: Reading document from wwwd. machn

Progress: 4.0 kB of 7.8 k8, at|1.0 kB per second

Click here to stop the currently selected process.
abgut 5 seconds eljpsed, about 5 spconds remaining

This is the address of the currently selected document.

Is this document being downloaded? Is the network
connection hung up on something? Is it coming from Mars?

Some things take forever... see exactly how much of your life
you’ve spent waiting for that slow web server right here.



Error Log

The Error Log contains all of the status messages and other information that OmniWeb
or a plug-in may output during processing of Web pages. Don’t worry, not everything
here is a problem — sometimes it’s just OmniWeb letting you know what it’s doing.

If it’s too much to handle, just clear it out.

(&) [&] Error Log
f Clear Log N O] Show HTTP requests

- Want to see everything that passes
version 4.1 sneaky peek 7 (10/31/01) " between OmniWeb and remote
servers? Check this box.

Oct 31 16:39:03 HTTPS plug-in 1.09d - 10/31/01, Copyright by OIC - Juergen
Moellenhoff <jm@oic.de=

Oct 31 16:39:03 OpenSSL 0.9.6b 8 Jul 2001, built on: Sun Sep 2 16:13:21 PDT 2001,
compiler: c¢ -arch i386 -arch ppe -g -03 -pipe -Wno-precomp -arch i386 -arch ppc -pipe
Oct 31 16:30:03 OpenSSL Options: bn(32,32), md2{int}, rcd{ptr,int),
deslidx,cisc,4,long), idea(int), blowfish(idx)

Oct 31 16:50:00 *** -[JSBrowserFrame proxy]: selector not recognized

Oct 31 16:50:00 <OHHTMLDisplayProcessor: 0x2fdb0f0=: Exception during script
execution: *** -[JSBrowserFrame proxy]: selector not recognized

Oct 31 16:50:00 *** [JSBrowserFrame proxy]: selector not recognized

A typical log message.

Oct 31 16:50:00 <OHHTMLDisplayProcessor: Ox2fdb0f0=: Exception during script v
execution: *™* -[JSBrowserFrame proxy]: selector not recognized 4
Show Info

If you want to know all the obscure facts about a certain Web page, then the Show Info
panel is definitely for you.

000 Document Info

\'\‘i The Omni Group: Applications:
OmniWeb

This represents the main HTML — &+l Document somnigroup_content £ 4
document in the browser window. Inline Imane esmnlgcoup. . Perspecthy
Inline image «omnigraup . download
Inline Image «omnigraup . US.gifs
Inline Image «aomnigraup__ DE gife
Inline Image «omnigraup_ FR.gifs

Outlined below it are all the
subfiles referenced by this page:
images, external style sheets and
scripts, frames in a frameset,

et cetera. Click the triangles to
expand and collapse groups.

Inline Image somnigroup...JP.gifs
Inline Image samnigroup...DK.gifs
Inline Image somnigroup... SE.gifs
Inline Image somnigroup...ES.gifs

Inline Image «omnigroup.. NLgifs 1

B URL hlluﬂ-f{wmv.ur;lmgmUD-(ﬂmflmﬂg'—ThiS is the URL to the selected item.
Select any item to see more ssfans gl
information about it in the fields e = The MIME type of a document tells
below L whether it’s an HTML file, an image,
. Size! 61 x 32 pinels, 494 bytes or something else.
Changed: 11-jun-2001 13:44:57 -0700
Expires: 11-0c1-200117.06.13 -0800 This information helps you tell when
the document expires from cache.
If you select an image, this area - { Referch )  Source ) ) . ) .
= Get it again, save it, show it in a new

will show a small preview of it. ———— < (saveas.. ) ( pisplay )

window, or view the source.

Searching the Web

We think Google is a great search engine, so

we’ve made it easy to search for pages there.

Type “google omniweb” in the URL field to do a
Google search for the word “omniweb”. You can set
up other search engine shortcuts like this in the
Shortcut pane of OmniWeb’s Preferences.

Opening URLs from Other
Applications

Use the Internet pane in System Preferences to set
your preferred web browser to be OmniWeb, and
links in other applications (such as Mail) will open
in OmniWeb when clicked.

Also, OmniWeb provides a Service for opening
URLs, which is useful when you see a URL in
another application which doesn’t appear as

a clickable link. Select the URL and choose
Services » Open URL in OmniWeb from the
application menu.
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Advice

We want you to have the best experience possible using OmniWeb.
So we’ve included a couple pages of tips and tricks that we
thought would help out. It’s not all the answers in the world, but

we think it’s a good start.

How do | make OmniWeb remember my window sizing and positioning?

Put the window in the place you want it to be, make it the right size, and select

Browser » Save Window Size. Then all new browser windows will be the same size as the
one you saved, and the first browser window you open (when there are no other windows)
will always open in the same place as the one you saved.

How do | get OmniWeb to open files of type X with application Y?

The usual way to do this in Mac OS X is to tell the Finder which application should be the
default application for opening a particular type of file. To do this, click on a file of that
type and select File » Show Info (Command-I). At the top of the Info window is a pop-up:
change it to Open with Application, and you’ll be able to choose which of your installed
applications opens that file, with the option of applying your change to all files of that type.

| filled out the Form AutoFill preferences, but when | select “AutoFill Form”, my info
doesn’t appear! What’s up with that?

What’s most likely going on is this: the field names you see in the left hand side of the
Forms AutoFill preferences panel must exactly match the ones that the web developer used
internally when constructing the form in HTML; for instance. What you've entered for “First
Name” won't be sent to the server if the page developer called that form field “fname” in
his code.

What does this mean? At least in the beginning, you still need to fill forms out by hand. But,
if you make a habit of clicking Browser » Save Form for AutoFill on forms before you submit
them, before too long, you'll notice that the Browser » AutoFill Form command is getting
more and more useful. The secret of Form AutoFill is that it gets more effective the more
you use it.



My bank says | can only do online banking with browsers that support 128-bit
encryption. Does OmniWeb support 128-bit encryption?

OmniWeb fully supports 128-bit secure HTTP (via the built-in OpenSSL framework in
Mac OS X); you can tell that we're surfing in secure mode when a small “lock” badge appears
on the zig-zag arrow icon in your browser window’s address field.

If you want to know exactly how many bits long the key we’re using for a given transaction
is, you can open the Tools » Error Log window; a message will list the key length we’re using
once a connection is established.

| tried to view a certain page, but the text is all garbage characters! What’s going on?

You're probably viewing a web site which uses a non-Latin character set. OmniWeb is capable
of handling almost any character encoding, but the web page or web server needs to

specify which character set a page should use — otherwise, the setting from your Display
Preferences will be used, and if that’s not a good match for what the author of the page
intended but didn’t specify, you'll get garbage results.

You could fix the problem by changing the Display preferences to a new character set and
reloading the page, but this would affect every browser window; if you find yourself only
needing to change this for a few pages your visit, you can add a Character Encodings popup
menu to your toolbar (see page 6 or the online help for how to customize the toolbar).

I think | found a bug? How can | get it fixed? Or
I need help! How can | get my question answered?

There is one thing you can do to increase the odds that your problem will get fixed as
quickly as possible, or that your question will get answered to your satisfaction the first time
you e-mail us: Reduce the amount of thinking we need to do, and increase the amount of
fixing we can do. Less thinking per problem means more problems fixed.

So, how can you make it so we think less and fix more? First of all, the more specific you
can be about the problem you're having, the better we can understand your problem and
offer solutions. Second, include as much information as is possible. Too little information
could either make it impossible to fix your problem, or worse yet, send us off on the wrong
tangent entirely.

Bad Example: “OmniWeb makes my favorite page look bad. It looks good in Internet
Explorer!”

Good Example: “My favorite page (http://www.omnigroup.com) has a grey chrome-looking
border and blue buttons when I browse it in Internet Explorer, but the border is plaid and
the buttons are red in OmniWeb. I'm using OmniWeb 4.1 on my PowerBook G4 with Mac
0S 10.1 installed.”
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